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December 9, 2025 
 

VOC – Central Locations for Favorite Saved Queries 
 

 
Path: Any Window > Browse Panel 
 

 
Path: Reports > Browse Queries 
  

  
Path: Navigation Pane > Favorites Section 
 

  
Path: Landing Page and Browse Queries 

Summary: You now have a way to mark as Favorite 
any of your saved queries and view a list of Favorite 
queries rather than scrolling through the individual 
Browse windows. 

Details:  

The process of marking a query as a Favorite is like 
marking other records as favorites. 

On the Browse Panel window, select the query and 
click the Star  icon. Favorite queries are then 
identified by a solid blue icon . 

You can also use the Bookmark  icon on the new 
Reports > Browse Queries window (described on the 
next page) to mark a selected query as a Favorite. 
NOTE: The User’s record must be updated from 
Admin > User Management > Records / Window 
Access Tab to see this new window. 

You can see the list of your favorite Browse Queries in 
the Navigation Panel Favorites section where they can 
also be deleted like other favorites. The list is also 
visible from the Landing Page using the drop-down 
menu of the Favorites  icon.  

When you click a Favorite query in the list, it 
automatically opens in the new UI. 

This is the December Voice of the Customer 
enhancement. We would like to thank the University 
of Northern Colorado for submitting this suggestion. 
We saw an opportunity to redevelop the page to be 
more user-friendly in all areas. WebTMA has evolved 
into the solution it is largely through great feedback 
and suggestions provided by our clients. 
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New Window for Browse Queries  
 

 
Path: Reports > Report Manager 
 

 

Summary: The Browse Queries window is available 
to select and view results for all queries in one place. 
It also allows you to see a list of Favorite queries (see 
previous topic). 

Details:  

To see this option on the Reports > Report Manager 
menu, the User’s record must be updated from Admin 
> User Management > Records / Window Access Tab. 

Simply select a Form, and the queries created for that 
window are available for selection in the Query field. 
When you choose a query, the results are 
immediately displayed.  

In addition to reviewing all queries, you have the 
option to mark or remove a query as Favorite using 
the Bookmark icon when you have selected a query 
to view. 

  = Not Favorite 

  = Favorite 

The Favorites  drop-down menu is also 
available on this window. 

You can also hide the Favorite Browse Queries list 

everywhere. Click the Star   icon to hide the 
Favorites Browse Queries on the Favorites drop-down 
menu on this window, the Landing Page, and on the 
Navigation Panel Favorites section. 

The Favorite status is not deleted. This toggle 
feature merely hides the access. To unhide the 

feature, click the Star  once more.  

NOTE: When you click to hide, you are alerted with 
the notice shown at left. 

 

ECRI Integration 
 
 
 

Summary: If your medical facility subscribes to the 
UMDNS™ data provided by ECRI, you can select the 



  3 

items you use and have them available in the 
WebTMA database. 

Details:  

This additional module applies only if you have also 
purchased UMDNS standard nomenclature and 
computer coding data from ECRI. 

Setup includes creating records in Lookups > Device 
Types. 

In addition, records are required for the product 
manufacturers in Organization > Vendors. 

Please contact your account manager for details on 
acquiring this new module. 

 

AI SmartScheduler Task Filter Updated 
 

 
Path: Transactions > Time Manager > AI 
SmartScheduler 
 

Summary: The Task display on the AI 
SmartScheduler dialog has been revised. 

Details:  

Tasks are now grouped based on the Task Code and 
can be filtered by Work Order Type. 

They can also be filtered by Location: Facility, 
Building, and Floor only. 

 

AI SmartScheduler Allows Manual Scheduling of No-Trade Tasks 
 
Path: Transactions > Time Manager > AI 
SmartScheduler 
 

Summary: You can now manually schedule Tasks 
that do not have a Trade assigned. 

Details:  

Tasks without a trade are identified with a different 
color. If a no-Trade Task has been previously 
scheduled, it is removed from the schedule and put in 
the hopper. 

You can now run the AI SmartScheduler regardless of 
whether a selected Task has a Trade or not. 

 

WO Location Information in SRP for Status and Search 
 Summary: When using the Status and Search pages 

of the Service Request Portal, the Location 
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Path: Admin > Form Attributes > Service Request 
Portal  
 

information is taken from the Work Order if the Work 
Order is not connected to a Request. 

Details:  

Previously, this information was not included in the 
Status and Search pages if the Work Order was not 
connected to a Request. 

 

Automatic Department Links for SRP 
 
 
Path: Admin > Form Attributes > Service Request 
Portal 
 

Summary: When records are associated with a 
Department, the Department field automatically 
populates on the Request record. 

Details:  

The hierarchy is as follows: 

 Building -> Department 

 Requestor -> Department 
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November 25, 2025 
 

VOC – Linked Documents Now in Browse Windows 
 

 
 

 
 
Path: Transactions > Request > Request Log – Find 
Path: Transactions > Request > Request Browse 
Path: Transactions > Request > Batch Validation 

Summary: Request browse windows now have an 
option to search for records with Linked Docs. You 
can then add Linked Docs on the Display 
Column Tab. In the grid column for Linked Docs, 
clickable links are displayed so that you can download 
or view documents depending on the type of link. 

Details:  

If a Request has multiple linked documents, you can 
click a link for a flyout that displays all the 
documents. These can also be viewed without having 
to leave the browse window. 

These new options are available for the following 
windows: 

 Request Log > Find 

 Request > Request Browse 

 Request > Batch Validation 

This is the November Voice of the Customer 
enhancement. We would like to thank the University 
of Northern Colorado for submitting this suggestion. 
We saw an opportunity to redevelop the page to be 
more user-friendly in all areas. WebTMA has evolved 
into the solution it is largely through great feedback 
and suggestions provided by our clients. 

 

Requestor Information for SRP Status and Search 
 
 
Path: Admin > Form Attributes > Service Request 
Portal 

Summary: When using the Status and Search pages 
of the Service Request Portal, the Requestor 
information is taken from the Work Order if a Work 
Order is not connected to a Request. 

Details:  

Previously, this information was not included in the 
Status and Search pages if the Work Order was not 
connected to a Request. 

The following information will be taken from the Work 
Order is there is no Request: 

 Requestor Name 

 Requestor Email 

 Requestor Phone 

 Action Requested 
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November 11, 2025 
 

Workday Integration 
 

 
Path: Admin > Workday 

Summary: A new Workday integration for Account 
Validation and General Ledger Posting is now 
available. More integrations will follow in the future. 
This is an additional module. 

Details:  

If you are a Workday client, this assures you can 
automate the process to save you time. 

This module helps you automatically reconcile 
between the WebTMA GL and the Workday ledger. 

Please contact your account manager for details on 
acquiring this new module. 

 

Update Owner Button Added to Find Window 
 

  
 

 
 
 

 
 

Summary: Specific users now have the option to 
change ownership of existing queries for any window. 

Details:  

If the logged in user is the original creator (Owner) or 
someone who is assigned an Admin Role, they can 
see and use the Update Owner button. 

1. Click the Show the Search Panel button on 
the navigation panel. 

2. Select an existing query. 

3. Click the Update Owner button on the panel. 

4. Select the new owner. 

5. Click Save. 

Note: Admin Roles are assigned in User 
Management, and the Update Owner button is only 
visible after you select a query. 

In many cases, the original Owner is no longer 
employed by your organization. This button is an easy 
way to allow an Admin to make changes to queries if 
needed.  
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Requestor Connections Added in SRP  

   
Path: Admin > Form Attributes > Service Request 
Portal–Forms 

Summary: In the Service Request Portal, you can 
now manually connect the Requestor Email and/or 
the Requestor Phone to the Requestor Name block. In 
addition, the Requestor Name or the Requestor block 
can be connected to the Department. 

Details:  

Previously, the blocks did not accept these 
connections. 

In addition, a new Requestor Set block has been 
added. This block has the Requestor Name, Requestor 
Email, and Requestor Phone connections pre-
populated. 
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October 28, 2025 
 

Check Group Alerts 
 

 
Path: Organization > General Inspections > Inspection 
Check Group 
 

 
Path: Organization > Task > Task Check Group 

Summary: If you attempt to delete the final check 
from an existing check group, a message now pops 
up to alert you to the consequences. This applies to 
both General Inspections and Tasks. 

For either window, deleting all checks from a group 
check disassociates the record from all other 
records where it is used. 

Details:  

In the past, when all checks were removed, the check 
group record was automatically disassociated even 
before you clicked Save. 

You now receive the warning shown at left when you 
delete a final Inspection Check or a final Task Check 
from the group record.  

Click Cancel to retract your action and preserve the 
check group’s association with other records. 

 

 

Project # Retained for Corrective Check WOs 
 

  
Path: Transactions > Work Order > Records / Identity 
Tab 

Summary: When Corrective Work Orders are created 
for General Inspections or Master Checks, the new 
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Work Order now carries forward a related Project # if 
present. 

Details:  

Project numbers are now carried over to Corrective 
Work Orders created from failed checks. This applies 
to: 

 Failed Master Checks (if Create Corrective WO 
is marked) 

 Failed General Inspection Checks (single task) 

 Failed General Inspection Checks (multi-task 
via Task grid button) 

This behavior also applies to WebTMA mobile. 

 

 

Additional Options for the Custom Field in SRP 
 

  
Path: Admin > Form Attributes > Service Request 
Portal–Forms 
 

Summary: When you create Forms in the Service 
Request Portal, the Custom Text Field block in the 
Block Palette now has more options for the Field To 
Affix Value To. 

Details:  

In addition to Additional Comments, you can also add 
the following to the Custom block: 

 Requestor Name  

 Requestor Email 

 Requestor Phone 

 Status 
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Report Form for WO Has Keys Criteria Options 
 

 
Path: Reports > Report Writer – Work Order 
 

 
Path: Reports > Report Writer – Criteria 

Summary: The Work Order Report Form in Report 
Writer now has details about Keys available for 
Criteria selection. 

Details:  

When you click the Add Criteria link in the Report 
Criteria section of the window, you now have the 
option to select any of the following Key details for 
your report: 

 Key Description 

 Key Holder ID 

 Key Holder Name 

 Key Number 
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October 14, 2025 
 

Language Setting Supported on New Interface 
 

 
              Landing Page in Spanish 
 

 
Path: Admin > Text Management – New UI Forms 

Summary: The new interface pages in WebTMA, 
such as the Landing Page, now support language 
selection. 

Details:  

A default language can be established for your 
organization from Admin > Client Info window. 

You can also select a different language for individual 
Users from the User record (Admin > User 
Management > Records). Reminder: When set from 
the User record, be sure to log out and log in again to 
see the change. 

Your custom labels made in Admin > Text 
Management / New UI Forms will modify all the new 
UI pages. 

The following new interface pages are affected: 

 AI SmartScheduler 

 ContractorHub 

 Service Request Portal 

 Mass Import 

 Bill of Materials 

 GIS 

 Data Subscriptions  

 

VOC – Bin Location Column Added to WO Cost Entry-Part 
Inventory 

 
Path: Transactions > Work Order > Records / Cost 
Tab-Work Order Cost Entry–Part Inventory 
(Part/Material flyout opened with ellipsis) 

Summary: When posting Parts or Material to a Work 
Order, the Part Inventory flyout has a new column: 
Bin Location. 

Details:  

The Work Order Cost Entry flyout opens when you 
click Post Part on the Work Order / Costs Tab. 

To see the Part Inventory flyout, click the ellipsis 
button for the Part/Material field. Most columns on 
this flyout can be filtered except Image or Serialized. 

This is an October Voice of the Customer 
enhancement. We would like to thank Cencora for 
submitting this suggestion. We saw an opportunity to 
redevelop the page to be more user-friendly in all 
areas. WebTMA has evolved into the solution it is 
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largely through great feedback and suggestions 
provided by our clients. 

 

 

VOC – Filters Added to Warehouse Part Inventory Tab 

 
Path: Material > Warehouses / Part Inventory Tab 

Summary: The Warehouses/Part Inventory Tab now 
has filters added to all columns. 

Details:  

All columns can be filtered in Edit mode. 

This is an October Voice of the Customer 
enhancement. We would like to thank Cencora for 
submitting this suggestion. We saw an opportunity to 
redevelop the page to be more user-friendly in all 
areas. WebTMA has evolved into the solution it is 
largely through great feedback and suggestions 
provided by our clients. 

 

ContractorHub Email Templates Added 
 

 
Path: Admin > Email Settings 
 

Summary: A ContractorHub Transaction Type is now 
available for you to create template content. 

Details:  

Your messages can be designed to help the contractor 
technician understand the work or find the location 
where work is to be performed. 

The following Events are available to create the email 
content: 

 Contractor Tech Assigned 

 Contractor Tech Un-Assigned 

 Send Contractor Tech Work Order Task Link 

 Send Contractor Tech Work Order Task List 
Link 

 Send Refreshed Contractor Task Link 
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September 30, 2025 
 

VOC – Work Order Simple Report with Bar Code 
 

 
Path: Transactions > Work Order > Records-Action 
Menu 
 

Summary: A new Simple Work Order report is now 
available for selection – Simple Work Order with Bar 
Code. 

Details:  

You can now choose which Simple Work Order meets 
your needs. 

The bar code is displayed in the upper left corner of 
the report. 

This is an October Voice of the Customer 
enhancement. We would like to thank Southern 
Illinois University-Carbondale for submitting this 
suggestion. We saw an opportunity to redevelop the 
page to be more user-friendly in all areas. WebTMA 
has evolved into the solution it is largely through 
great feedback and suggestions provided by our 
clients. 

 

VOC – Notification & Escalation Enhancement 
 

 
Path: Admin > Notification & Escalation 
 

Summary: A WO Charge field has been added to the 
Notification & Escalation window. Use of this field 
allows you to filter for Work Orders you want to close. 

Details:  

The field is visible when you choose a Transaction 
Type of Work Order. Use it to determine the Work 
Orders you want to close. You can use this field 
without marking the Close Work Order check box. 

By default, the All option is selected but you can also 
select Chargeable Only and Non-Chargeable Only. 

This is an October Voice of the Customer 
enhancement. We would like to thank the University 
of Missouri–Columbia for submitting this suggestion. 
We saw an opportunity to redevelop the page to be 
more user-friendly in all areas. WebTMA has evolved 
into the solution it is largely through great feedback 
and suggestions provided by our clients. 
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Notification & Escalation Field Name Change 
 

 
Path: Admin > Notification & Escalation 
 

Summary: The label Escalate to Work Not Done has 
been changed to Close Work Order; however, the 
functionality has not changed. 

Details:  

When you mark this check box, it forces the job to 
expire when a Work Order meets the established 
criteria.  If the Work Order includes labor lines, it is 
closed. If no labor has been entered, Work Orders are 
marked as Work Not Done, and the Work Order is 
closed.  

The rules of this window require an entry on the 
Email Tab for this action to occur – even if no 
message is needed. 

 

Re-Export for UI 
 

 
Path: Transactions > Work Order > Records 
Path: Transactions > Request > Request Log 
Path: Material > On-hand Adjustments 
Path: Accounting > Accounts Payable Invoice > 
Accounts Payable Invoice 
 

Summary: When you use UI to export information, 
you may have times when you need to export an item 
again. The option to re-export records has been 
added for those occasions. Several windows now 
accommodate the action with a Re-Export link on the 
Action Menu. Select the link to be able to export the 
record once more. 

Details:  

Look on the Action Menu of the following windows for 
the new option: 

• Work Order (UI for Work Order Export) 
• Request Log (UI for Work Requests)  
• On-hand Adjustments (Universal Procurement 

Interface) 
• Accounts Payable Invoice (Universal Accounts 

Payable Invoice) 
 

 

Material Requests on SRP 
 
 
Path: Admin > Form Attributes > Service Request 
Portal 
 

Summary: The Cost in Materials Request for the 
Service Request Portal now includes the full price 
charged to your customer of the material used. 

Details:  

If you use a markup on Parts, for example, the 
requestor sees the amount they are charged, which 
includes the markup. 
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GI Inspection Check Group Sequencing Added 
 

 
Path: Organization > General Inspections > Inspection 
Check Group 
 

Summary: Lines in the Inspection Check Group 
window can now be re-sorted easily. 

Details:  

Previously, the only way to re-order the list was to 
remove checks and add them back in the desired 
order. 

A new Sequence column indicates the order and can 
be changed when you click the Edit button for a line, 
which automatically opens the Inspection Check 
Group Sequence flyout where you can enter the value 
of the desired position. The list re-sorts when you 
save the page. 

Any Inspection Form that uses that Group Check is 
automatically updated with the new order. 

NOTE: This new sort order does NOT apply to 
existing Work Orders that have already received a 
list. You can see the results for lists on new Work 
Orders. 

 

Mass Import Now Includes Sub-Types for Locations 
 

 
Path: Admin > Mass Import / Templates 
 

Summary: The Mass Import templates for location 
windows now accommodate Subtype as well as Type. 

Details:  

The following Templates have the Subtype column: 

• Area 
• Floor 
• Building 
• Facility 
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September 16, 2025 
 

Query Sorts Can Be Saved Globally by Admins 
 

 
Path: From any Records page, open the Find panel 
 

Summary: A new check box on the Find window 
allows anyone with an Administrator Role to save the 
sort setting on any query and make it the global 
default. 

Details:  

Only those with the Administrator Role can make 
these changes that are displayed globally and on the 
Dashboard. 

For Administrator Role logins, the Set Current Sort as 
Global Default check box is enabled. 

You can take these steps to set a Sort order: 

1. Select a Query Name. 

2. Click Find. 

3. Click the header to sort the desired column. 

4. Mark the Set Current Sort as Global Default 
check box. 

5. Save Query. 

The new sort is reflected on the query for all who 
view it from the Dashboard or from a module. 

The Administrator can also rearrange Display 
Columns. These are shown on the Dashboard but not 
the Find grid. 

 

View Charge Total Added to SRP Search Status Tab 
 

     
Path: Admin > Form Attributes > Service Request 
Portal / Searches – Status Tab 

Summary: The Search form for the Service Request 
Portal gives you the option to show the individual 
Work Order charge total. 

If you want your client to see charges related to their 
request, you can use the new Work Order Charge 
Summary block on the Status Tab. Use Settings to 
select the columns you want your client to see. 

Details:  

When your client searches for a Request/Work Order 
you can choose whether they can see relevant 
Financial Data for their request.  

Please note this is the Charge total and not the Cost 
total since the Charge total can be different from the 
Cost depending on your use of markups and rate 
schedules.  
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Analytics Dashboard Saved Views 
 

 
Path: Reports > Analytics 
 

Summary: You can now create, edit, save, and 
delete your Analytics Dashboard views. 

Details:  

Use the buttons to the right of the Saved Dashboard 
Views field to perform the desired action. 

Once you have saved your view, use the drop-down 
in the Saved Dashboard Views field to select the 
desired view. 

The saved views are only available to the person who 
created them. 

Note the initial window setting now displays 
dashboards only – not the drill-down or non-
dashboard. 
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September 2, 2025 
 

Mass Import Details Available for Import History 
 

  
Path: Admin > Mass Import / History Tab 

 
 

Summary: You can now see the details of any import 
listed on the Mass Import / Import History Tab. 

The import detail list that appears when you first 
import data is now available for later review. 

Details:  

Click the import name in the Import List section to 
open the Import Details window to see a summary 
and all details of the import. 

SFTP imports also show up in the import list and 
corresponding import details. 

This applies to all imports – past and future. 
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Mass Import Additional Mappings 
 

 
Path: Admin > Mass Import - Create 
 

Summary: You can map your own Excel spreadsheet 
for import using the new Additional Mappings section. 

For those who use text files, these imports are also 
supported. 

Details:  

The Additional Mappings section is visible in the first 
step of creating an import. 

If your data is already in an Excel format, you can 
map it and save your mapping settings to reuse in 
the future. 

Text import mappings can also be saved in the same 
way. 

Note: We do not support custom strings or 
langstrings that have been applied in Admin > Text 
Management. 

 

Email Template Has Scheduled Event for Requestors 
 

 
Path: Organization > Repair Center > Records / Email 
Settings 
 
Path: Admin > Email Settings 
 

Summary: The Email Template now has a new Event 
option for Work Order Transaction Type settings. The 
new option is: Scheduled. 

Details:  

With Scheduled selected on an email template, you 
can send a notice to the Requestor that the 
Technician has been scheduled to the Work Order. 

The To field displays Requestor when you select 
Scheduled in the Event field. 
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New Key Access Report View Added to Database Views 

 
Path: Material > Key Management > Keys / Access Tab 

Summary: A new view for Keys Access has been 
added to Database views. The new view is: 
vrpt_keyAccessLockLocation 

Details:  

This view displays all the Lock information including 
child keys linked to the main parent Key. 

Views are used for reporting for SaaS clients with 
Direct Database Connect or the Business Intelligence 
module. On-premise clients are strongly encouraged 
to use these views for reporting, rather than querying 
directly against transactional tables. 

Click here to see the List of WebTMA7 Database Views 
in the Knowledge Base. 

 

SSO Login for Service Request Portal Enhanced 
 
 

Summary: Users that are currently logged in using 
SSO are no longer routed back to the SSO Login page 
a second time when they click a Service Request link. 

Details:  

Previously, all users were required to complete the 
SSO Login page regardless of whether they were 
logged in. 
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August 19, 2025 
 

VOC – Last Activity Added to User Record 
 

 
 
Path: Admin > User Management > Records / Identity 
Tab 
 

 
Path: Reports > Report Writer / Identity Tab 
 

 
Path: Reports > Report Writer / Layout Tab – Add Field  

Summary: The User / Identity Tab now includes a 
Last Activity field to show the last time the user was 
active in the system. 

Previously, you had to search through the Session 
Logs for this information. 

Details:  

If someone logs in at 8:00 and works continuously 
until 11:10, the Last Activity field shows 11:10. This 
is the same information found in the Session Log.  

The date is tracked whether the login was to the main 
application or the WebTMA Mobile application (not 
WebTMA GO or mobileTMA GO). 

This view is also available for Direct Database 
Connect, writing queries within the application, and 
report development. 

For example, you can create a report in Report Writer 
to see who is using the system and who is not. Use 
the Report Form for User to list all active users in 
your system with the last activity date for each user. 

This is the August Voice of the Customer 
enhancement. We would like to thank Graham Houser 
at the University of Illinois-Urbana/Champaign for 
submitting this suggestion. Many clients also voted 
for this in the UC25 Election for direction. We saw an 
opportunity to redevelop the feature to be more user-
friendly. WebTMA has evolved into the solution it is 
largely through great feedback and suggestions 
provided by our clients. 

 

UFI Budget Codes for Contractors 

 
Path: Organization > Lookups > Vendor Types 

Summary: A new Budget Code field on the Vendor 
Types window applies to Credit Account Codes for 
Contractors. This relates to the UFI module.  

The Budget Code only affects Work Orders where a 
Contractor performed the work and there are 
Contractor Costs.  

Details:  

When Work Orders are closed and posted for a 
Contractor with a Vendor Type that has a Budget 
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 Code, the charges are shown as credits when 
exported from UFI. 

If the Contractor Type record does not have an 
assigned Budget Code, no Vendor Credits are 
exported. The related cell on the exported data file is 
empty. 

As before, Debit charges look to the Budget Code for 
the Task used on the Work Order. These are set in 
Lookups > Task Types. 

 

Email Template Enhanced 
 

 
Path: Admin > Email Settings 
 
Path: Organization > Repair Center > Records / Email 
Settings 
 

Summary: The Email Template Entry flyout has been 
enhanced to show the general recipient of the email. 

Details:  

The new To field is read-only and changes based on 
the contents of the Transaction Type and Event fields. 

In the example, when the Transaction Type is Work 
Order and the Event is Schedule Tech, the To field 
indicates the message will be sent to a Technician. 

Other combinations follow these rules: 

 If the Transaction Type is Approval Routing, 
show Authorizer. 

 If the Transaction Type is Survey Response, 
show Notification Recipients. 

 If the Transaction Type is Work Order and the 
Event is Schedule Tech, show Technician. 

 If the Transaction Type is Work Order and the 
Event is Schedule Trade, show Trade. 

 For other combinations, display Requestor. 
 

Capital Request Revisions Updated 

 
Path: Transactions > Capital Requests > Capital 
Request Revisions 

Summary: The Capital Request Revisions window 
now automatically populates the Work Elements on 
the Details Tab. 

Details:  

When you add a new Capital Revision record and 
select the Capital Request on the Identity Tab, all 
Work Elements associated with that Request are 
automatically loaded into the grid on the Details Tab. 

Funding can be edited from the Details Tab.  

You can add new Work Elements using the Add Work 
Element link. 
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More Work Orders Included in Service Request Searches 
 

 
Path: Admin > Form Attributes > Service Request 
Portal – Searches Form 
 

Summary: Work Orders not connected to a Work 
Order requisition are now included in the search 
results. 

Details:  

Other rules still apply. The Work Order number in the 
Request # or WO # field must be affiliated with the 
Requestor Email that is entered. 
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August 5, 2025 
 

Work Order Schedule Start Date on SRP Status Tab 
 

  
Status Tab of a Service Request Form 
 
Path: Admin > Form Attributes > Service Request 
Portal 
 

Summary: The Block Palette on the Service Request 
Form now includes a field named Work Order 
Schedule Start Date on the Status Tab of the Form. 

Details:  

When used, the system looks to the earliest 
Technician’s scheduled start date to populate the 
information. 

 

 

Validate PMs Based on Season Start and End Dates 
 
 

 
 PM Schedule Entry flyout 

Summary: PMs for items that use Season Start and 
Season End dates are checked to assure that at least 
one of the dates falls within the season.  

You are alerted if the next PM date is set outside the 
season dates. 

Previously, setting a PM outside season dates meant 
the PM was not generated. 

Details:  

When dates are entered, the following rules apply: 

• Season End cannot occur before Season Start 

• Both Season Start and Season End dates are 
required fields 

• At least one projected next PM date must 
occur between the Season Start and Season 
End dates. This applies to both fixed and 
floating PMs. 
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API Endpoints Enhanced 
 

 
 
 

Summary: Our Work Order endpoints now show the 
last person who closed a work order.  

Details:  

To use the endpoints, do a Get on the 
WorkOrder/{id} found in the Swagger WebTMA 
Platform API. 

This applies to APIs only.  

 

Landing Page WOs Open in New Tab on Right-Click 

 
 

 
 

Summary: Work Order records shown on the 
Landing Page can now be opened in a New Tab or 
New Window using the right-click drop-down menu.  

Details:  

This applies to Work Orders on both Landing Page 
Tabs (Work Orders and Active Tasks). 

Hold the mouse pointer over the Work Order number 
and right-click.  

Select your choice from the drop-down window to see 
the Work Order record in a new Tab or Window. 

This allows you to see details without closing the 
Landing Page. 
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July 22, 2025 
 

VOC – General Inspection Individual Check Validation Added 
 

 
Path: Organization > General Inspections > Inspection 
Form / Layout Tab 
 
 

Summary: You can now make individual General 
Inspections checks required before task closure. This 
is done from the Inspection Form / Layout Tab. 

The required fields are applicable within the 
application and for legacy mobile products (WebTMA 
GO and mobileTMA GO). 

Previously, the only way to require checks was the 
global setting that required ALL checks to be 
completed before closure. This is made at Admin > 
Client Info / Preferences - General Inspections global 
setting “Require all inspection checks to be done 
before closing/finishing work order”.   

Details:  

To mark a check as required, go to Organization > 
General Inspections > Inspection Form / Layout Tab 
and expand the second tier. Mark the check boxes in 
the Required column for any checks you want to 
require. 

The required checks are designated with a red 
asterisk (*). Until all required checks are completed, 
the inspection cannot be marked as completed. 

This is the July Voice of the Customer enhancement. 
We would like to thank Marshfield Clinic, Inc. for 
submitting this suggestion. We saw an opportunity to 
redevelop the feature to be more user-friendly. 
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients. 

 

AI SmartScheduler Now Available 

 
Path: Transactions > Time Manager > AI 
SmartScheduler 
 
 

Summary: The new WebTMA scheduling tool, AI 
SmartScheduler, gives you the option to have AI 
create a schedule for those who use Time & 
Attendance. 

You have the option to accept or revise the results. 
You also control the Tasks and Trades that are 
included in a schedule. 

Using the AI feature saves you time but still gives you 
control. 

Details:  

To enable the feature, grant your users appropriate 
permission to use the module. Go to Admin > User 
Management > Records / Window Access Tab and 
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add permission for AI SmartScheduler in the Time 
Manager section. 

While the AI SmartScheduler windows are fairly 
intuitive to use, good results are only achieved if your 
data is prepared.  

Task Preparation: The AI SmartScheduler requires 
an estimate of Task duration to generate and 
manipulate a work schedule. Be sure your Tasks have 
times to complete in hours. The system looks first at 
the Labor Standard field or if the field is empty to the 
Average Time field. 

Technician Preparation: Any Technician assigned 
to Tasks by the AI SmartScheduler must be assigned 
the correct Trade or Trades and must also be 
assigned a Shift. The shift must be defined for the 
start and end shift times as well as days of the week 
that are worked. 

Once your data is ready, the AI SmartScheduler 
window offers information about existing Tasks and 
Hours assigned to your Trades as well as an 
opportunity to immediately create schedules with or 
without the assistance of AI. 

 

Scheduler Window Quick Filter Changes 
 

 
Path: Transactions > Time Manager > Scheduler 
 
 

Summary: When you set criteria in the Scheduler in 
the Quick Filter section to review Technicians 
assigned to a Work Order, two new fields have been 
added, and the Zone field has been moved and 
relabeled. 

Details:  

New fields labeled Building Name and Department 
Name are available on the right side of the Quick 
Filter section. 

Originally, a field labeled Zone was on the right. It 
has been moved to the left and labeled Technician 
Zone to clarify that the field is to filter technicians.  

The grid below the Quick Filter section also includes 
Department and Building columns. 
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Requestor Name List Added to Service Request Portal 
 

 
Path: Admin > Form Attributes > Service Request 
Portal  
 

Summary: The block palette on the Form / 
Submissions Tab of the Service Request Portal has a 
new Requestor option: Requestor Name List.  

Previously, the Requestor Name was the only option, 
but this field lacks the option to select from a list of 
requestor names.  

Details:  

The new Requestor Name List field is a free text field 
and drop-down that allows your user to select a 
requestor.  

Connecting the Requestor Name List field to Location 
fields auto-populates those Location fields once a 
requestor is selected.   

When using an anonymous user, auto-populate may 
not work as intended due to the selected anonymous 
user’s assigned access to Location data.  

NOTE: The Requestor Name field is available and is 
still the default name field when creating a new Form. 
Either the Requestor Name or the Requestor Name 
List can be used in a Form, but not both. Use the 
Requestor Name field if you do not want your users to 
see other requestor’s names. 

 

Work Order Contract Quick Information 
 

  

 
Path: Transactions > Work Order > Records / Identity 
 

Summary: If a Contract is assigned to a Work Order, 
you can easily view Contract details with one click. 

For single-task jobs, click the  Information icon 
next to the Contract # field. For multi-task jobs, click 
the Contract # link in the grid. 

Details:  

The flyout that opens when you click either the icon 
or the link shows the following information about the 
Contract: 

 Contract # 

 Contractor Code 

 Contractor Name 

 Contract Type 

 Award Date 

 Agreement 

 Comments 
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Task Sheet Rich Text Is Now Optional 
 

 
Path: Organization > Task > Records / Identity Tab 
 
 

Summary: The Task Sheet section of the Task / 
Identity Tab now defaults to Plain Text with an option 
to Use Rich Text (formatted text). 

Details:  

While many customers want to add formatting to the 
Task Sheet, this is not true for all. 

By default, the Task Sheet section now uses Plain 
Text. To format the text, you can check the Use Rich 
Text box. 

Note the highlighted alert above the Task Sheet field 
when you check Use Rich Text. It alerts you that: 

“Saving as Rich Text could result in MarkDown 
characters being printed or displayed in reports.” 
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July 8, 2025 
 

ContractorHub Now Available 
 

 
 

 
 

   

Summary: The ContractorHub is a dedicated work 
order access for contractors that is easy and intuitive. 

It is designed to benefit both your administrative staff 
and your contractors. In addition, it is a less costly 
approach than the current WebTMA method of 
contractor assignments. 

Details:  

Your administrative staff can assign work orders in 
batch to the Contractor. 

Contractor Managers enter the names and email 
addresses of their Contractor Technicians and assign 
the work orders. 

When assigned, the Contractor Technicians receive an 
email with a link to a simplified version of the work 
order that the technician can view on a mobile device 
(phone or tablet).  

As work progresses, the technician can enter basic 
information such as arrival time, status, and 
comments. 

The Contractor Manager updates the tickets rather 
than burdening your staff with the task. They can also 
attach a .pdf copy of their invoice if needed. 

The ContractorHub requires a separate license. Please 
contact your Account Manager for more information. 
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Time & Attendance Labor Adjustment Icon  
 

 
Path: Transactions > Time Manager > Time & 
Attendance 
 

 
 

Summary: If you make Labor Adjustments to a Work 
Order, a  gold dollar sign icon now displays on the 
Time & Attendance list of labor lines. 

Details:  

Click the  icon to open the Labor Adjustment View 
flyout to see details about the adjustment. 

 

P-Card Transaction Added Columns on Card Flyout 
 

 
Path: Material > P-Card > P-Card Transactions 
 

 
Path: Organization > Repair Center > Technician / P-
Card Tab 

Summary: When adding a new Card to the window, 
the Card flyout that opens when you click the ellipsis 
icon for the Card # field now has additional columns. 

Details:  

Previously, this flyout window showed Issuing Bank 
and Last4Digits. 

With this release, you can see the following: 

• Card Holder 
• Card Type 
• Card # 
• Issuing Bank 
• Expiration Date 
• Last 4 Digits 

 

The Card Holder column relies on information added 
to the P-Card Entry flyout on the Technician’s record 
(Repair Center > Technician / P-Card Tab). Be sure to 
add Technician’s name as the Primary Name on the 
flyout. 
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June 24, 2025 
 

VOC – Copy My Dashboard Tabs 
 

 
Path: My Dashboard 
 
 

Summary: An easy-to-use Copy feature has been 
added to My Dashboard. You can now copy an 
existing Tab using the Toolbar command. 

Details:  

Open the tab you want to duplicate and click Copy on 
the toolbar. 

On the MyPage Tab flyout, change the name and 
description, click Save, and you have a new tab 
identical to the original. 

If desired, you can change the number of Columns in 
Layout. 

You can edit and adjust the new Tab if needed. You 
can use Delete on the toolbar to remove it if you copy 
a Tab in error. 

This is the June Voice of the Customer enhancement. 
We would like to thank The Church of Jesus Christ of 
Latter-day Saints and other clients who spoke up in 
the TMA community for submitting this suggestion. 
We saw an opportunity to redevelop the page to be 
more user-friendly. WebTMA has evolved into the 
solution it is largely through great feedback and 
suggestions provided by our clients. 

 

Equipment PM – Fail Work Order Options 

  
Path: Transactions > Work Order > Records 
 

Summary: Equipment PM Work Orders can use a 
new Action Menu link – Fail Work Order. The link 
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opens a popup with two options to process the 
Equipment records and Work Orders: 

 Deactivate Equipment 

 Create Corrective Work Order 

Details:  

The Action Menu Fail Work Order option is only 
enabled for Equipment PM records. 

When Fail Work Order is selected, you can choose 
either option shown on the Confirm popup. 

The selections affect the Task settings on the original 
Work Order as well as on the Equipment record. 

When you click Deactivate Equipment: 

 The Work Order is Closed including a date in 
the Closed Date field.  

 Any Tasks on the Work Order are marked as 
Work Not Done and Failed PM on the Work 
Order Task Entry flyout. 

 The Equipment record is deactivated, i.e., the 
Active check box is cleared. 

When you click Create Corrective Work Order, a 
copy of the Work Order opens. 

 Change the WO Type Description (PM not 
allowed). 

 Note the Source System is shown as Failed 
Work Order. 

 After the new Work Order is saved, the Linked 
WO Tab displays the original Work Order. 

 The Original Work Order is marked as Closed, 
the Closed Date is populated, and all Tasks 
Order are marked as Work Not Done and 
Failed PM on the Work Order Task Entry 
flyout. 

 The Equipment record remains Active; 
however, dates are not changed in the Last 
Calibration and Calibrated Through fields until 
the corrective WO is closed. Once the new 
WO is closed, the Closed Date of the 
corrective WO populates the Last Calibration 
field and Calibrated Through is calculated 
from the Last Calibration using the PM 
interval. 

 

Manual Reset for Tasks Average Time 
 Summary: WebTMA is hard wired to calculate the 

Task Average Time every night and insert this 
calculation in the Average Time field. Sometimes the 
resulting calculation does not match the desired value 
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Path: Organization > Lookups / Time Types 
 
 

 
Path: Admin > Client Info 
 
 

due to changes in labor hours that have already been 
calculated. 

With this change, if you elect to include or exclude 
certain Time Types, e.g., travel times, you can 
choose the Time Types that are included in the 
calculation and manually reset the averages for all 
Tasks of that Type at one time. 

Details:  

Be sure to mark the Include in Task Time Averages 
check box on any Lookups / Time Type that applies. 

To recalculate the averages for all Tasks of the 
marked Types, go to Admin > Client Info, and select 
Recalculate Task Time Average on the Action Menu. 

This flags calculations to be made during the next 
update. Changes are visible the next day. 

 

 

 

New RRule to Set Weekday Only PMs 

 
Path: PMs Tab and Batch PM Update 
 

Summary: The Repair Center has an option to 
specify the PM Week when PMs are performed for 
either 5 or 7 days. If you use the new RRule Calendar 
Schedule, you can specify Week Days Only, for PM 
items, i.e., 5 days. 

Details:  

The new Week Days Only check box is only enabled 
when you mark the Use Modern Interval Pattern 
check box (the new RRule). 

If the selected Repair Center for the item has a PM 
Week of 5, the Week Days Only check box is locked 
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by default to conform to the rules for the Repair 
Center. 

If you select multiple PM schedules to edit and any 
PM has Week Days Only marked, all PMs selected 
have the check box marked and locked.  

The Week Days Only check box is locked as well for 
Make/Model if the Repair Center has a PM Week of 5.  

 

Capital Setups Window Revised 

 
Path: Transactions > Capital Setups / Identity Tab 
 

Summary: The Budget Information Section on the 
Capital Resets window has been moved from the 
Worksheet Tab to the Identity Tab. Three fields are 
now required in this Section. 

Details:  

The required fields are: 

 Budget Year 

 Start Month 

 Budget Type 

These changes were made because the fields are 
required for the processes in the Capital Planning 
Process batch job to work correctly. 

 

Capital Planning Batch Job Processing Time Reduced  
 
Path: Admin > Batch Management / Capital Planning 
Process 
 

Summary: To improve processing time, 
optimizations were made to the Capital Planning 
Process batch job. 

Details:  

In our testing, we were able to reduce processing 
time from a two-hour run time to 12-13 minutes. 
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June 10, 2025 
 

Rental System Report Forms Include New Selections 

 
Path: Reports > Report Writer 
 

Summary: The Report Form selection window for 
Report Writer now includes two additional options. 

Details:  

You can now select the following Report Forms: 

 Posted Rental Charges 

 Rental 

 

Flat Rate Applied on Work Order Costs Tab 
 

 
Path: Transactions > Work Order > Records / Costs 
Tab–Work Order Cost Entry flyout 
 

Summary: Calibrated MWI records that have a 
Usage Flat Rate on the item’s Rates Tab or the MWI 
Types / Rates Tab can now apply the rate using Post 
Test Items on the Work Order / Costs Tab. 

Details:  

Once the item is selected for the Work Order, the 
flyout Charge check box on the Work Order Cost 
Entry flyout is enabled. A mark in the box populates 
any of the following (if available): 

 Unit Cost 

 Unit 

 Account # 

Mark the Flat Rate? check box to change the Quantity 
field to a value of 1 and replace the Unit Cost with the 
Flat Rate value from the MWI or MWI Type record. 

If the selected MWI has Usage Rate values these are 
used. If not, the MWI Type value is used. If neither 
have a Flat Rate, nothing is populated. 
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UFI Account Validation Added 

 
Path: Accounting > Universal Financial > UFI Setup 
 

Summary: This new UFI Account Validation process 
runs automatically each night. 

Details:  

When the batch job begins a new Post Charges 
process, a forced UFI Account Validation will execute 
if at least 30 minutes have passed since the last 
validation. 

The Batch Job Service calls the UFI Web Service. 

The UFI Web Service is installed locally in your 
environment and configured to connect to your 
financial system database. It must be publicly 
accessible so that the WebTMA batch job service can 
connect. 

Access to the UFI Web Service is secured via an 
API Key. 
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May 27, 2025 
 

PM Interval Selection Defaults to Legacy 
 

 
Path: PMs Tabs 
 

Summary: When setting a PM Schedule, a new check 
box, Use Modern Interval Pattern, gives you the 
option to opt for the new RRule interval or use the 
Legacy version.  

By default, the box is unchecked, meaning you are 
using the Legacy interval pattern. 

Details:  

Mark the check box to see the options using the new 
recurrence rules. 

 
The Use Modern Interval Pattern check box is 
available on the PMs Tabs on MWI windows, Tasks, 
and anywhere PMs are scheduled, such as the Batch 
PM Update window when you use the PM Schedule 
Mass Update popup. 

REMINDER: The new recurrence rules do not apply 
to Floating PMs. 

 
 

Topaz Signature Pad Supported in WebTMA 7 
 

 
 

Summary: If you use Topaz Signature Pads, 
WebTMA 7 accommodates the pads if they are 
plugged in. No other setup is needed. 

Details:  

Any time you click Signature on the Action Menu (for 
windows that have that option), WebTMA 7 
recognizes the Topaz Signature Pad.  

You may notice a flash of the smaller signature 
window before a somewhat larger signature box 
displays. Other than that, it works the same as the 
regular Signature box. 

When you install Topaz from 
https://www.topazsystems.com/sdks/sigweb.html 
and, if you have an HSB Topaz device, be sure to 
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choose HSB/HSX rather than HSB alone. HSB devices 
go to the HID device rather than a COM port. 

HSB models work automatically, but BSB models may 
require you to select a specific COM port when you 
install SigWeb. 

 

UFI Template Assignment Has Added Upload Functionality 
 

 
Path: Accounting > Universal Financial > UFI Template 
Assignment 

Summary: The UFI Template Assignment window 
allows you to select .csv file names for upload. You 
can also choose to upload zipped files. 

Details:  

The Zip File box is checked by default to upload 
compressed files. 
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May 13, 2025 
 

 

VOC – Format Task Sheet on Task Window 
 

 
Path: Organization > Task > Records / Identity Tab – 
Task Sheet Section 

Summary: You can now add formatting to the Task 
Sheet Section of the Task window. 

Details:  

Using standard formatting tools, you can insert: 

• Headings 
• Bold, Italics, and strike-through text 
• Lateral lines 
• Quotation marks 
• Bullets and numbered lists 
• Links 

The formatting is converted to plain text in our legacy 
mobile applications and reports. The WebTMA Mobile 
application does reflect this format. 

This is the May Voice of the Customer enhancement. 
We would like to thank Cencora for submitting this 
suggestion. We saw an opportunity to redevelop the 
page to be more user-friendly in all areas. WebTMA 
has evolved into the solution it is largely through 
great feedback and suggestions provided by our 
clients. 

 

Order Sequence Column Added to Task Check Group 
 

 
Path: Organization > Task > Task Check Group 

Summary: A new column (Order #) has been added 
to the Task Check Group window. 

Previously, the only way to determine the sequence 
that checks were listed was to add them in the order 
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wanted. Now you can enter the Checks in any order 
and change the sequence using this new column. 

Details:  

In Edit mode, click the line edit button  to 
open the Task Check Group Sequence flyout. 

Enter the sequence number desired, click Save on the 
flyout.  

When you Save the full record, the lines are re-
ordered. 

You can also change the order later if needed.  

 

Task Check List Reflects Changed Group Check Sequence 
 

 
Path: Organization > Task > Records / Task Check List 
Tab – Task Sheet Section 

Summary: Group Checks added to the Task / Task 
Check List reflect any changes you make to the sort 
order described in the previous topic. 

Details:  

Note that the Order # column on the Task Check List 
Tab reflects the same number for each Group line, 
but if you change the line sequence on the Task 
Check Group window, the lines within the Group are 
re-sorted on this Tab as well. 

 

Work Order Check Results Reflects Sequence Numbers 

 
Path: Transactions > Work Order > Records 

Summary: The Work Order Check Results flyout 
reflects the list of tasks in the latest sequential order 
until the results are saved. 

Details:  

Where the Task / Task Check List shows the same 
number for each line in the Group, the Check Results 
list follows a normal 1, 2, 3… sequence. 

Changes made to the sort order on the Task Check 
Group window are reflected on this flyout until it is 
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Path: Transactions > Work Order > Records - Check 
Results 

saved. Once you click Save on the flyout, the 
sequence remains fixed. 

Any changes made on other windows after the list is 
saved are not reflected on the Check Results flyout.  

The sequence is also shown on the mobile 
applications. 
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April 29, 2025 
 

VOC – Batch Finish Added to WO Browse Window 
 

 
Path: Admin > User Management > Records / 
Preferences Tab 
 

 
Path: Transactions > Work Order > WO Browse 
 

Summary: The WO Browse window now includes a 
Finish Selected button to batch update selected 
records as finished if a new User Preference is 
granted. 

Details:  

To see the button, first grant the Preference for your 
Users or Groups. If you are testing the feature on 
your own login, be sure to log out and log in again to 
see the new button. 

The Finish Selected button behaves in the same way 
as the Close Selected button. Mark the check boxes of 
the desired records, click the Finish Selected button, 
choose OK, and select the date/time. 

This is the April Voice of the Customer enhancement. 
We would like to thank Brent Critchley from Greece 
Central School District. His suggestion was added to 
the Election for Direction at the User Conference. 
Thank you to those attendees who also asked for this 
enhancement. We saw an opportunity to redevelop 
the page to be more user-friendly in all areas. 
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients. 

 

UFI Account Segments Expanded to Fifteen 
 

 
Path: Accounting > Universal Financial > UFI Segment 
 

Summary: If you use the Universal Financial module, 
UFI Segments have been increased from 9 to 15. 

Details:  

For imports, an error message alerts you if there are 
more than 15 segments in the account number. 

The import fails and the log file shows “Maximum 
Account Segments Exceeded” with the offending 
Account number. 

This change supports integration with the Workday 
application. 
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Path: Accounting > Accounts 
 

 

UFI Template Setup Has Additional Columns 
 

 
Path: Accounting > Universal Financial > UFI Setup 
 

 
Path: Accounting > Universal Financial > UFI Template 
Setup 

Summary: If the Application field on the UFI Setup 
window is Workday Financials, the UFI Template 
Setup window includes separate Debit and Credit 
lines and columns. 

Details:  

You now have the option to use two columns rather 
than a single Debit/Credit column. The separate lines 
can be used depending on how your ERP handles 
debits and credits. 

This change also supports integration with the 
Workday application. 
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‘Require Failure Code to Close’ on Task Window 
 

 
Path: Organization > Task > Records / Identity Tab 
 

Summary: The Tasks / Identity Tab now has a 
Require Failure Code to Close check box. 

Details:  

This feature makes sure that the Failure Code is 
always indicated. 

By marking the new check box, you can assure that 
Work Orders that require Failure Codes always have 
them before the Work Order can be closed. 

This applies to in-application records and is not 
currently available in mobile devices; however, it will 
be enhanced at a later date. 

 

New Work Order Field: Last Sensor Notification 
 

 
Path: Transactions > Work Order > Records / Identity 
Tab – More Information 

Summary: Work Orders generated through the 
Smart Business Integration module show this field to 
indicate the last time an alert was sent from the 
sensor regarding a failure issue. 

Details:  

Since the outside software continues to send frequent 
alerts after the Work Order has been created, the 
date and time in this field assures you that the alert 
has been received and is still an active problem. 

 

Service Request Portal Access Notification 
 

 
Applies to both Service Request and Material Request 

Summary: Both the Service Request and Material 
Request Forms for the Service Request Portal have an 
indicator to show the type of access used. 

Details:  

The text of the button changes based on selected 
access. 

Click the button to select a different access. 
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April 15, 2025 
 

QP Cost Account # Now Defaults to WO Costs 
 

 
Path: Transactions > Quick Post > Quick Post Cost 
 

 
Path: Transactions > Work Order > Records / Cost Tab 
 

Summary: Costs entered from the Quick Post 
windows frequently have an associated Account # 
that automatically populates that field. Previously, 
that Account # did not carry over to the related cost 
line on the Work Order / Cost Tab. With this change, 
the account number displays on the Work Order cost 
line regardless of limits placed on the Account # field 
(described in the Details below). 

Details:  

Your System Administrator can disable the Account # 
field from Admin > Form Attributes > System Form 
Attributes so the account cannot be changed on the 
Quick Post window. Regardless of this setting, the 
Account # still appears on the Work Order cost line. 

For example: The Account # field on the Quick Post 
Time Labor Entry window is disabled. The intention is 
to prevent a user from manually changing the 
Account #. At the same time, the client wants the 
default Account # to be saved to the database, i.e., 
to show up on the Work Order / Cost Tab. Note: The 
Account # populates the field with the number that is 
associated with the Technician record. 

 

Additional Languages Supported in WebTMA 7 
 
 

Summary: WebTMA now supports the languages 
listed below for default text labels, menus, and 
messages. Words entered by your users in text fields 
are not translated (Comment field, Name field, 
Request, etc.). 

Except for Malay, these languages are also accessible 
from legacy mobile products as well. 

Details:  

Your WebTMA Administrator determines the default 
language used in the application; however, individual 
users’ preferred settings can be made from the User 
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record or from the File > Personal Info window. These 
settings override the Client Info selection.  

NOTE: If you change the personal or User record 
settings, log out of the system. When you log in 
again, you can see the language change. 

The following list shows the additional languages that 
are now supported: 

 Greek 

 Italian 

 Japanese 

 Korean 

 Chinese Trad 

 Arabic 

 Russian 

 Malay 

 Turkish 
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April 1, 2025 
 

medTester Interface for WebTMA 7 
 

 
 

 
Path: Admin > medTester Exception 

Summary: We have updated the medTester 
Interface to work with WebTMA version 7. Many 
WebTMA healthcare clients heavily use the medTester 
product for electrical safety testing and performance 
verification. 

Details:  

The WebTMA 7 medTester Interface performs the 
same functions as in version 5 with a few changes for 
ease of use. 

NOTE: You will need to configure a TMA user account 
with credentials in TMA to use the medTester 
functionality even if you use SSO to log into the main 
application. 

Button Functionality 

A Login to WebTMA button has been added as a main 
button. This is more convenient than having it on the 
menu. 

The Generate Checklist / Upload to medTester button 
performs the same functions as two separate buttons 
in the previous version (“Send All Checklists” and 
“Send Filtered Checklist”). You have the option to 
filter for certain files or simply click Send without 
filtering before uploading files. Using this button pulls 
checklist data from WebTMA; creates import files; 
and pushes the files to the medTester Device.  

A new Resend Check List to medTester button is 
used to resubmit, when needed, the files that were 
uploaded using the Generate Checklist / Upload 
button described above. 

To provide better understanding of the functions it 
performs, the Download from medTester / Submit 
Results button is a new name for “Resend Last 
medTester Files”. It downloads check results from the 
medTester Device, writes them as a file, reads the 
file, and submits to WebTMA. 

Another new button name is Re-Submit Results 
(formerly “Upload Results”). It was renamed to make 
it more consistent and better explain its use. Click the 
button to see a prompt for a result set that has been 
previously generated by medTester and re-submit it 
to WebTMA to resolve Sync Exceptions. 

Changes 

When results from medTester (MUP files) are 
submitted to WebTMA and the entire dataset is 
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processed without any errors or exceptions, the file is 
automatically moved to a Processed subfolder.  

If the dataset generates errors or exceptions, the file 
remains where it is and a medTester Exception record 
is generated that can be seen in WebTMA (Admin > 
medTester Exception). Exception records cannot be 
added, edited, or deleted. 

Exception records are resolved by re-submitting the 
results after correcting any issues. For example, 
missing Biomed Equipment (usually missing related to 
data access) or invalid data in WebTMA (wrong Tech 
ID, invalid task, etc.). To correct the data before 
resubmitting, update in either medTester or WebTMA 
records, depending on the source. 

Once you resubmit data and it processes successfully, 
the medTester Exception record is updated as 
‘Resolved’ and the Is Valid flag is cleared. 

 

Analytics Grid Layout 

 
Path: Reports > Analytics 

Summary: For clients who purchase the Business 
Intelligence feature, the additional Analytics module 
presents a list of your reports in an easy to search 
grid format. 

Details:  

Use the Filter icon to search for Analytics and see 
your results. 

 

 

Make Queries Public, Public/No Edit, or Private 

  
 

 
 

 
Example of Owner Indicator for Public/No Edit 

Summary: When you use the Find flyout, you can 
create either a one-time search or save your query 
for repeated use and select designated access.  

Details:  

When you click the Save Query or Save Query As 
button, the Query Access flyout gives you several 
options. 

You can designate the Repair Center to which the 
query applies or leave it blank and search all Repair 
Centers. 

In addition, you can designate who can see or use the 
query.  

Here are the properties of the three settings: 

• Public. This query is available to all users. 
Anyone can save or delete the query. 
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• Public/No Edit. Users can view and use the 
query, but they cannot save or delete the 
query. Only the owner, i.e., the person who 
created it, can make changes. 

• Private. The query is invisible to all users 
except the owner. Only the owner can save or 
delete this query. 

 

New UI Context Sensitive Help 
 

 
 

Summary: Context sensitive help is now available for 
the new UI windows.  

Details:  

Click the Question Mark  icon at the upper right to 
open online help about the current page. 

The new windows now open Help the same as using 
the Question Mark  icon in other parts of WebTMA 
7. 
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March 18, 2025 
 

Batch PM Update Supports New Recurrence Rules 
 

 
Path: Admin > Batch PM Update 

Summary: The new PM Recurring Pattern that uses 
the industry standard RRule has been extended to the 
Batch PM Update window. 

As a reminder, the new calendar scheduling rules 
apply to Fixed PMs. The previous rules apply to 
Floating PMs. 

Details:  

All desired check boxes must be marked to save 
changes. 

If you have not completed all required fields for the 
new scheduling rules, an alert notifies you that, “Next 
PM Date, Interval, and Frequency are required.” 

 

 

Map Action Requested and Comments in Service Request Portal  

 
 

Summary: Contents of the Custom Text Field block 
(found in the Custom Affixed section of the Service 
Request Form) can be mapped to certain other fields. 
This allows you to append the contents to the 
mapped field.  

When you edit your Custom Text Field, you can 
specify whether to affix the field values to the Action 
Requested or Additional Comments fields in your 
Form.  

Details:  

Field values are concatenated in the Action Requested 
or Comments fields. 

Frequently, this is information that does not show on 
the Work Order but is needed by a Technician. 
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Path: Admin > Form Attributes > Service Request 
Portal 
 

Source Field Added to Work Order 
 

 
Path: Transactions > Work Order > Records 
 

Summary: A new System Source field has been 
added to the Work Order window. 

Work Orders created by copying a Work Order now 
display "WO Copy" as the source in this new field and 
requestor details (name, phone, and email) are 
cleared on the copied work order. 

The first source available in this field is WO Copy; 
however, the source of some generated work orders, 
such as Failure Code, will be added in the future. 

Details:  

Look to the More Information section for the read-
only System Source field. 

The Work Order Source ID can be queried, found in 
reports, and is accessible in DDBC.  

NOTE: When a new Work Order is created, this field 
remains blank by default. 
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Source Field Added to Notification & Escalation 
 

 
Path: Admin > Notification & Escalation 
 

Summary: The new Work Order Source concept is 
also applied in the Notification & Escalation window. 

Details:  

In the General Information section, look for the 
Source field. This is another optional rule for filtering 
work orders. 

Currently, the Source field drop-down is available for 
IoT records and Work Order Copy. Failure Code will 
be available in the future. 

Like the Work Order System Source field, the Work 
Order Source ID can be queried, found in reports, and 
is accessible in DDBC for Notification & Escalation.  

 

 

UPI – AP Payment Import Column Added 
 Summary: If you use the Universal Procurement 

Interface to import AP Payments into WebTMA 7, you 
can specify line-item payments in the Mappings Grid. 

Details:  

The columns include: 

• Payment Amount (from line-item) 
• Amount (from header) 

Both are listed by default in the Mappings Grid. 
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Path: Admin > Universal Interface 
 

Column Added to UPI – AP Invoice Export 
 

 
Path: Admin > Universal Interface 
 

Summary: If you use the Universal Procurement 
Interface to export AP Invoices from WebTMA 7, you 
have a new Column selection. 

An Extended Cost column has been added to the 
WebTMA Column selection drop-down list. 

Details:  

Use this field to map to your Remote Column. 
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API Platform – PO and PR Linked Document Endpoints 
 

 
 

Summary: Linked Document API endpoints are now 
available to export documents to your accounting 
system.  

These are read-only documents that are attached to 
Purchase Orders and Purchase Requisitions.  

Details:  

You can transfer a read-only Linked Document that is 
attached to a Purchase Order or Purchase Requisition 
using the Swagger API Platform. 

These new APIs are fully described in our Swagger 
documentation. 
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March 4, 2025 
 

VOC – Executive Dashboard Reject Request Option 
 

 
Path: My Dashboard 

Summary: Those who use the Executive Dashboard 
module on My Dashboard now have the option to 
Reject requests. 

Previously, managers only had an Accept option for 
requests on the dashboard. 

Details:  

The new Reject column contains a red X button 
(Reject) next to the green check button (Accept). 

This is a March Voice of the Customer enhancement. 
We would like to thank Jefferson Health for 
submitting this suggestion. We saw an opportunity to 
redevelop the page to be more user-friendly in all 
areas. WebTMA has evolved into the solution it is 
largely through great feedback and suggestions 
provided by our clients. 

 

VOC – PM Recurring Pattern Uses RRule* 
 

 
 

 
 
Path: PMs Tabs 

Summary: We have revised the Calendar Schedule 
section for PMs on the PMs Tab for both Tasks and 
Items.  

For many years, our clients have requested a way to 
schedule for the third Tuesday, a given day of the 
week, or other specific pattern. You can do that with 
this new recurring pattern that is similar to MS 
Outlook or iCal. 

The change allows you to be more precise in setting 
dates as well as selecting multiple days of the week 
on a single schedule. Previously, separate schedules 
were needed to specify different days.  

Details: 

RRule is an industry standard in calendaring that 
implements the same standard recurring events you 
can see in email applications such as Outlook, Gmail, 
etc. This gives you more exact generation of PMs 
either by a date or a recurrence pattern. 

The difference you see on the WebTMA interface is a 
few more options on the window. This update also 
provides projected dates. 

When changing the schedule, you can see the next 
four projected dates to give you a sense of how this 
works. Be sure to test these settings to gain a 
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better understanding of the process because it is 
somewhat different from the previous settings. 

Following are examples of results when using a 
setting by Day or Day of Week: 

Setting for Day 14 Would give the following dates: 

Friday, Mar 14, 2025 

Monday, Apr 14, 2025 

Wednesday, May 14, 2025 

Saturday, Jun 14, 2025 

Setting for the Second Friday has the following 
results:  

Friday, Mar 14, 2025 

Friday, Apr 11, 2025 

Friday, May 9, 2025 

Friday, Jun 13, 2025 

NOTE: Floating Schedules are NOT supported by the 
RRule. Currently, existing PMs use the old style, and 
new PMs follow the RRule. For new dual-based 
(Meter and Calendar) PMs, the calendar portion 
follows the new rules. In a future release, you will 
be able to change existing PMs to the new rule. 

This was a February Voice of the Customer 
enhancement that was slightly delayed because of the 
complexity of the enhancement. We would like to 
thank Cencora for submitting this suggestion. We saw 
an opportunity to redevelop the page to be more 
user-friendly in all areas. WebTMA has evolved into 
the solution it is largely through great feedback and 
suggestions provided by our clients. 

* RRule refers to a rule or repeating pattern for 
recurring events. 

 

Delete Sales Order Pending Items 
 Summary: Sales Orders are used to sell (charge) 

materials to various departments within your 
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Path: Material > Sales > Sales Order 

organization. If your order exceeds the amount on 
hand, items are backordered. 

Pending Items on the Action Menu is used to see if 
back-ordered items are in stock. Line items only 
display when stock is available.  

The Pending Items flyout now includes an option to 
delete items you do not need. 

Details: 

When you select a Department in the upper grid, the 
back-ordered items now available are visible in the 
lower grid. 

Check the lines you want to delete and click the 
Delete link to remove them. 

 

Service Request Portal Allows Dept.–Acct. Auto-Population 

 
Path: Admin > Forms > Service Request Portal 

Summary: The Service Request Submission and 
Material Request Submission Forms have default 
auto-populating behaviors for Department and 
Account blocks. 

Details: 

If the Form includes both the Department and 
Account blocks, an entry in the Department field 
causes the Account field to be populated with the 
Department’s Account number. 

If the logged-in user accessing a Form has an 
assigned Department, the Department field is 
automatically populated with the user’s Department. 

  

Mass Import Template for Meter Readings 
 

 
Path: Admin > Mass Import 

Summary: Our customers continue to request 
enhancements to the Mass Import module, and in 
response, WebTMA continues to add more templates. 

With this release, you can now import Meter 
Readings. 

Details: 

Like other Templates for Mass Import, you can 
download and complete the spreadsheet before 
creating an import. 

 

UPI – Purchase Order Export – Re-export 
 Summary: The Purchase Orders window has a 

feature related to UPI-Purchase Order Export. If the 
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Path: Material > Purchase > Purchase Orders 

export fails, you now have a way to re-export the 
files. 

This feature is also available for UPI-Purchase 
Requisition Export. 

Details: 

A Re-Export link on the Purchase Orders window 
Action Menu is available when needed. 

The Re-Export link on the Purchase Requisitions 
window Action menu has the same purpose. 
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February 18, 2025 
 

Material Request Added to Service Request Portal 
 

 
Path: Admin > Form Attributes > Service Request 
Portal–Material Request 

Summary: The Service Request Portal (SRP) now 
includes a Material Request form that allows your 
requestors to ask for the Parts or materials they 
need. 

This is another enhancement to SRP to make your 
request links easy to create and easy for requestors 
to use. 

Details: 

Like other SRP forms, you can use the Block Palette 
to drag the desired features to your Material Request 
page. 

Standard buttons, links, Requestor, and Organization 
blocks are available. 

In addition, Parts, Sales, and shipping information 
can be added. 

 

Mass Import Templates for Meters 
 
 
Path: Admin > Mass Import 

Summary: Our customers continue to request 
enhancements to the Mass Import module, and in 
response, WebTMA continues to add more templates. 

With this release, you have two new selections: 

• Meter 
• Meter Type 

Details: 

Like other Templates for Mass Import, you can 
download and complete the spreadsheet before 
creating an import. 

 

Email Multiple Techs from WO Schedule Tab 
 

 

Summary: The Work Order / Schedule Tab includes 
icons to Email details to a Technician.  

When more than one Technician is assigned to the 
work, you can now click the  icon in the heading to 
open a flyout window and select some or all 
Technicians who need to have the message. 

Details: 

This feature was available for those who used 
WebTMA v5, and it is now included in WebTMA v7 as 
well. 
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Path: Transactions > Work Order > Records / Schedule 
Tab 
 

UPI – PO Export Has Double Quote Option 
 
Path: Admin > Universal Interface Setup / UPI – 
Purchase Order Export (Transaction Type) 

Summary: When some clients export to another 
application, their lines may contain commas, tabs, 
and special characters. This causes errors when 
importing to the outside application. 

You now have the option to export the flat file and 
use double quotes if you have updated services. 

Details: 

Since this is not needed by most users, updated 
services are required to use the enhancement. 

 

Trade Window Shows Inactive Technicians 
 

 
Path: Organization > Repair Center > Trade / 
Technician Tab 

Summary: The Trade / Technician Tab has a new 
Active column. Empty check boxes indicate an 
Inactive Technician. The check boxes are read-only. 

Details: 

Previously, the list on the Trade / Technician Tab did 
not distinguish between Active or Inactive 
Technicians. 

When a Technician record is marked Inactive, this is 
now reflected on the Trade / Technician Tab. 

 

UPI – AP Invoice Export Now Includes UDF Values 
 

 
Path: Admin > Universal Interface Setup / UPI – AP 
Invoice Export (Transaction Type) 

Summary: The UPI – AP Invoice Export Transaction 
Type for the Universal Interface module, now includes 
UDF fields for column selection. 

Details: 

Previously, the UDF fields were not available. 
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Inactivate Part Lines from Warehouse Module 
 

 
 

 
Path: Material > Warehouses / Part Inventory Tab 

Summary: The Warehouse / Part Inventory Tab 
includes an Active column with check boxes to 
inactivate a SKU line that has zero (0) Parts on-hand. 

Previously, a change to the check boxes on the 
Warehouse / Part Inventory Tab did not save. 

Details: 

Having the option to inactivate SKU lines for several 
line items at one time is more efficient than opening 
each Part record to perform the same function on the 
Parts / Locations Tab. 

If you save inactivated SKU lines on either the 
Warehouse window or the Parts window, the action is 
reflected on the appropriate Tabs of both windows.  

NOTE: This does not inactivate the entire Part 
record. It only affects lines on the Part Inventory or 
Locations Tabs with zero (0) Parts on-hand. 

 

UDF Field Name Visibility Extended for Request Log 
  Before 

 
  After 

 
Path: Transactions > Request > Request Log 

Summary: If your UDF options have very long 
names, you can now see the full name by hovering 
over the ellipsis in the drop-down list. 

Previously, the selection only showed the first 50 
characters although the field can allow up to 250 
characters. 

Details: 

With this change, hover your cursor over the field and 
the ellipsis to see the full name in a tooltip. See 
illustrations at left for the “before” and “after” 
examples. 
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February 4, 2025 
 

VOC – SRP Searches Block for Work Order Cost Summaries 
Report 
 

 
Path: Admin > Form Attributes > Service Request 
Portal–Searches 

Summary: The Searches form in the Service Request 
Portal (SRP) now includes a Report block named Work 
Order Cost Summaries. 

The Report is easy to use. It provides WO costs and 
does not require a login to WebTMA. 

Details: 

You can build an SRP Searches page with the report 
as the only component. Your regular themes are 
applied, and the published report resembles the 
illustration at the left. 

The published report grid shows work order 
transactions with many details. Scroll across to see 
several cost columns. The default report is a 90-day 
time frame, but it can be changed.  

On the published report, use the filters to find lines 
you want. Published reports can be exported to Excel 
if needed. 

This is our February Voice of the Customer 
enhancement. We would like to thank Villanova 
University for submitting this suggestion. We saw an 
opportunity to redevelop the page to be more user-
friendly in all areas. WebTMA has evolved into the 
solution it is largely through great feedback and 
suggestions provided by our clients. 

 

Client Info URL Login Usage Visible 
 

 
Path: Admin > Client Info / Session Log Tab 

Summary: A new column on the Client Info / Session 
Log Tab indicates that the session was started using a 
URL login.  

Details: 

A check in the URL Login column shows the login lines 
that are attributable to a URL Login.  

The information does not indicate the individual who 
has logged in, but it does show administrators if 
someone is logged in via the URL login. 

 

Work Order Labor Extended Retail Field Available (Report Writer) 
 Summary: When you create a report in Report 

Writer and select Work Order Labor for your Report 



  64 

 
Path: Reports > Report Writer / Report Form (Work 
Order Labor) 

Form, the Extended Retail field is now available for 
selection. 

Details: 

On the Layout Tab, click the Add Field button to open 
the Select Display Fields flyout. You can now select 
Extended Retail from the list of available fields. 

 

Equipment Serial # Search in Fast Find 
 

 
Path: Equipment > Records 

Summary: The Fast Find – Search field at the top of 
the Navigation Panel is an easy way to search for 
records when you know a record number (whole or 
partial). 

On the Equipment window, you can now use the Fast 
Find field to search for a record by Serial #. 

Details: 

This offers the option for a quick search by Serial # 
as well as Tag #. 

 

Browse Panel Enhanced 
 

 
Path: Top of Navigation Panel 
 

Summary: Queries on the TMA Browse Panel for any 
window can be personalized for the logged-in user. 
Simply click-and-drag to resize and rearrange 
columns. 

Details: 

Click the Save Layout button to save these changes 
for the user; however, the default layout is still in 
force for others who open the Browse Panel. 

Click the Edit button on the revised query to open the 
Find window (overlaid on your TMA Browse). On the 
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Display Column Tab, you can see the default Column 
Name and Width.  

Select the Find button on this window, and the grid 
reflects how others see this query. 

 

 



  66 

January 21, 2025 
 

Improved Space Management for Requestors 
 

 
Path: Admin > User Management > Requestors / 
Identity Tab 
 

 
Path: Admin > User Management > Requestors / 
Location Tab 

Summary: Requestors can be associated with Areas 
as Occupants. Previously, Occupants could only be 
associated with a single Area, but now they can be 
associated with multiple Areas. As an example, a 
university professor can be associated with both an 
office space as well as a classroom space. 

Enhancement of several windows in WebTMA now 
allows for a full list of people related to a space. 

This gives you insights into the current landscape of 
your campus planning, and Requestors can quickly 
see all spaces that relate to them. 

Principal Investigator Areas were added to provide a 
tracking tool of people using the space and the ability 
to report on that usage for reporting and recording 
purposes. 

Details: 

These changes are represented or available in the 
following windows: 

• User Management > Requestors (Identity Tab 
and Location Tab) 

• Organization > Areas > Records / Occupants 
Tab 

• Transactions > Request Log (auto-completes 
related location information assigned to the 
Requestor) 

• Transactions > Work Order > Records (auto-
completes related location information 
assigned to the Requestor) 

• Reports > Report Writer 
• Search/Find window options 

The Preferred setting is made on the Requestors / 
Location Tab. 

A percentage of “ownership” is determined on the 
Areas / Occupants Tab. 

Once assigned, these are available in the other 
windows mentioned to use, search, and report on. 
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UDF Field Block Now Available in SRP 
 

 
Path: Admin > Forms > Service Request Portal 

Summary: In the Service Request Portal, the 
Request Details section of the Block Palette now 
includes UDF Field. 

Details: 

The UDF fields are those set up on the Request Log 
window. To make them available, the UDF fields must 
be configured from Admin > System Form Attributes 
for RequestLog. 

These fields might be used to capture data needed to 
process the request or for the type of Form in use, 
such as event seating, an alternate contact, or an 
Account Index that is not tied to account numbers. 

 

 

Customize Attached Files Text in SRP 
 

 
Path: Admin > Forms > Service Request Portal 

Summary: The Links and Attachment section in the 
SRP Block Palette includes a File Upload block.  

It can be edited when you want to modify the 
wording on the button and/or the placeholder text.  

You can change the text for NO-FILES PLACEHOLDER 
and SELECT FILES BUTTON TEXT in the Edit Block 
Settings popup for your File Upload block.  

Details: 

You have the option to change the text for both the 
button and the placeholder. 

By default, the button shows Choose files. The Label 
for that section of the block palette is Attached Files. 

If desired, you can also remove all text on the button. 
The remaining indicator is the upload graphic as 
illustrated below. 
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Hierarchy Alerts in SRP Linked Blocks 
 

 
 

  
 
Path: Admin > Forms > Service Request Portal-Form 

Summary: When you link Location blocks in the 
Service Request Portal Form, new warning  and 

information  icons are available to assure the 
needed hierarchy blocks are in your design. 

Details: 

Move your cursor over the warning icon  to see a 
list of the connections expected by this block as 
illustrated at the left. 

The information icon  provides details about the 
block such as the Building information illustrated at 
left. 

Note that, once you have linked the blocks, you have 
the option to move them to other areas of your 
design Form. 

 

New UFI Setting to Retain Trailing Segment Separators  
 

 
Path: Accounting > Universal Financial > UFI Segment 

Summary: The default for the UFI Segment is to 
remove trailing separators from account strings; 
however, some users require that they be retained. 

A new Keep Trailing Separator check box on the UFI 
Segment window gives you that option. 

Details: 

If your process requires the inclusion of trailing 
separators to indicate empty segments, mark this 
new check box. 
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January 7, 2025 
 

VOC – UDF Now Available for UPI – AP Payment Import 
 

 
Path: Admin > Universal Interface Setup 
 
 

Summary: Use the UPI – AP Payment Import 
Transaction Type to import payment records using 
the Universal Interface framework. 

Your UDF fields are now included on the Add Column 
flyout in the Universal Interface Setup window. 

Details: 

When you click the Add Column link to open the Entry 
flyout, you can select your UDF fields from the 
WebTMA Column drop-down list. 

Be sure to add the UDF fields to Admin > System 
Form Attributes for the Purchase Order page to see 
the fields. 

This is our January Voice of the Customer 
enhancement. We would like to thank Jefferson 
Health for submitting this enhancement suggestion. 
We saw an opportunity to redevelop the page 
completely to be more user-friendly in all areas. 
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients. 

 

Parts Location Tab Now Has Enabled WO Link 
 

 
Path: Material > Parts > Records / Locations Tab 
 
 

Summary: The Audit Trail flyout on the Parts / 

Locations Tab is opened when you click the  Eye 
icon to see all details about a Part line. 

Details: 

The Work Orders column on the Audit Trail displays 
all Work Orders that have the Part assigned. The 
Work Order # is now an enabled link so you can 
review the associated Work Order with one click. 

 

UI Receivings (Staging) Import Enhancement 
 

 
Path: Admin > Universal Interface Setup 

Summary: The Receiving (Staging) Import UI 
transaction is used to import Receivings from your 
ERP. The information is held in the database until it is 
approved from the Receiving Staging window. 

However, not all clients require the extra approval 
action. To avoid this step, mark the new Auto Receive 
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check box when the Transaction Type selection is 
Receivings (Staging) Import. 

Details: 

When using Auto Receive, you bypass the review 
process. 

If all Parts on a Purchase Order are auto-received, the 
PO is automatically closed. 

NOTE: The function cannot auto-receive serialized 
Parts. 

 

New Selections for UPI PO and PR in Universal Interface 
 

 
Path: Admin > Universal Interface Setup 

Summary: Clients that use the WebTMA Universal 
Interface module sometimes have processes for 
importing POs and exporting PRs that differ from the 
usual WebTMA process.  

To allow you to choose the import or export function 
that matches your workflow process, two new 
selections have been added. 

Details: 

Look for the following new Transaction Type 
selections: 

UPI - Purchase Order Export 
UPI – Purchase Requisition Import 

The screenshots below show available fields for 
Purchase Requisitions Import and some of the many 
fields available for Purchase Order Export.  

Other fields that are available for Purchase Order 
Export include PO#, RC Code, Line Quantity, and 
UDF fields. 
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    Available Fields for Purchase Requisition Import 

 

  

 

Copies of Release Notes for 2024, 2023, and 2022 can be found in the Knowledge Base. 


